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1

INTRODUCTION

1.1

Scope
[1]

1.2

1.3

This document User Manual, identified as ARR-ATSA-SO11-004, describes the work done and the
design and use of the Acoustic Tracking System (ATS) for Autonomous Underwater Vehicles (AUV)
software implemented by Array Systems Computing Inc. (Array) under the W7707-115263/001/HAL.

Background
[1]

Array has been contracted by DRDC-Atlantic to produce software in IDL and LabVIEW capable of
localizing a Autonomous Underwater Vehicles (AUV) in real-time by using data provided through
hydrophones, GPS, and acoustic modems.

[2]

The AUV Acoustic Tracking System being developed for the upcoming 2011 Project Cornerstone
Arctic field trial has two main components. First, a transducer is installed on each of the vehicles
which generates a hyperbolic frequency modulated (HFM) acoustic signal (or a similar signal with a
narrow autocorrelation function) of fixed time duration at predetermined regular time intervals.
Second, an above water system is being developed that relies on the existence of a stable ice pan(s),
where a Beacon Camp and three Remote Node stations are to be deployed. Each of the Remote Node
stations are evenly distributed around the Beacon Camp at approximately a 3 km radius. A Remote
Node consists of a hydrophone, an acoustic modem, a GPS, and a FreeWave radio to link the node to
the Beacon Camp. All three remote nodes shall be programmed to regularly transfer their hydrophone
data (from the received HFM signals) and the GPS positions to the Beacon Camp for processing. In
addition, the Beacon Camp will consist of a Cross-Dipole Hydrophone Array (CDHA), an acoustic
modem, and a GPS.

[3]

Array will be developing the IDL and LabVIEW modules that integrate into a framework capable of
performing the signal processing, communication, and optimization necessary to effectively localize
the AUV.

Document Overview
[1]

This document is structured into the following sections:
•

Section 1 provides an overview of the document.

•

Section 2 lists the project deliverables.

•

Section 3 provides procedures for software installation.

•

Section 4 contains the user manual.

•

Section 5 describes the application programming interface.
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1.4

Acronyms and Abbreviations
[1]

Table 1 shows the acronyms and abbreviations used in this document.

Table 1. Acronyms and Abbreviations
Acronyms and Abbreviations

Explanation

API

Application Programming Interface

Array

Array Systems Computing Inc.

ATS

Acoustic Tracking System

AUV

Autonomous Underwater Vehicle

CDHA

Cross-Dipole Hydrophone Array

CSV

Comma Separated Value

DRDC

Defense Research and Development Canada

FFT

Fast Fourier Transform

GPS

Global Positioning System

GUI

Graphical User Interface

HFM

Hyperbolic Frequency Modulation

LOFAR

Low Frequency Analysis and Ranging

NOAA

National Oceanic and Atmospheric Administration

TIFF

Tagged Image File Format

WGS

World Geodetic System

XDR

External Data Representation
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2

DELIVERABLES
[1]

The following were delivered as part of the work:
•

Developed Software
o

•

•

Third-Party Software
o

One Node-Locked IDL 8. License for Windows (http://www.ittvis.com)

o

One Labview Base Development System for Windows
(http://sine.ni.com/nips/cds/view/p/lang/en/nid/1385 )

Hardware
o

•

ATSA Software (described in Section 4.0)

Two 4U Desktop/Railmount Workstations with the following configuration:


CPU: Intel Xeon series Quad-core I7-950 3.06GHz



RAM: 12 GB



HDD: 1 TB



Video Card: GE Force 8400GS



DVD RW



Microsoft Windows 7 Professional Edition 64 bit

Documents
o

User Manual (this document describing the work done, design and use of the developed)
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3

SOFTWARE INSTALLATION
[1]

Unzip the .zip file and you will get a directory with lib and src subdirectories. The lib directory
contains unmodified DRDC provided code, and the src directory contains the in-progress source code.

[2]

To get the code running, you will need to either add the top-level atsa directory to your IDL path (see
Window -> Preferences -> IDL -> Paths) and have the ‘include subdirectories’ checkbox on, or create
an IDL project (and have the IDL path automatically set).

[3]

The tactical plot includes support for displaying a georeferenced TIFF file. We have been using the
NOAA ETOPO1 global relief data set from http://www.ngdc.noaa.gov/mgg/global/global.html (we
have been using the grid-registered, but the code should handle either grid or cell). Note that this data
set might be too large for displaying the entire globe (if you want to do that, try using the 2-minute or
5-minute resolution datasets), but will work fine once the lat/lon limits of the tactical have been
trimmed down a bit.
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4

USER MANUAL
[1]

Once the path has been set, try running the tim_test procedure in the src directory. You should have
an ATSDebugDialog window appear. Additional displays can be created via the buttons in the
Displays tab.

[2]

The ATSDebugDialog is a Graphical User Interface (GUI) for injecting synthetic data into the system,
bringing up various displays and printing state information. Initially, the data plots will be empty, but
if you press the ‘Generate Acoustic Data’ button on the CDHA tab, a set of CDHA data will be
created.

[3]

You can set the AUV pulse type by going to the Parameters tab and bringing up the AUV dialog, or
from one of the data windows using the Edit -> AUV Parameters menu option. In the AUV
Parameters dialog, press ‘Choose’ beside the pulse filename field, and picking a file.

[4]

Once a pulse has been chosen, press the ‘Generate Acoustic Data’ button in the CDHA tab and data
should appear in the various data plots.

[5]

The GUI is composed of the following major functions:
•

Plots of acoustic or non-acoustic data. This includes lofargrams, sound speed profiles and the
tactical plot. These may be accessed via the ‘Displays’ tab of the ATSDebugDialog.

•

Configuration dialog boxes to define various settings.
‘Parameters’ tab of the ATSDebugDialog.

•

The test data generation and debug functions of the ATSDebugDialog.

These may be accessed via the

[6]

Figure 1 illustrates the processing flow used to generate the AUV position estimate.

[7]

Significant algorithmic steps are implemented in separate procedures that can be run in isolation.
When run in this manner, the individual algorithms use default parameters and print all of their results.
The
relevant
procedures
include
compute_time_delay,
compute_arrival_angles,
compute_auv_range_and_depth and compute_first_auv_position_estimate.
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Figure 1: ATSA Processing Flow

4.1

Plots
[1]

There are some features common to all of the data plots.
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4.1.1

[2]

Readouts should be shown for the current mouse location at the bottom of the window.

[3]

Windows can be resized and the plots should adjust accordingly.

[4]

Dragging with the left mouse button will select a region of a plot.

[5]

The right mouse button will bring up a menu to zoom in (to the selected region if there is a selection,
or just zoom in a bit otherwise), zoom out or to reset the zoom settings to show all of the data again.

[6]

In the menu bar (we currently use the same one for all windows), there are options in the Edit menu
for changing various settings. If you update any of the display settings and press Apply or OK, the
display should update accordingly.

[7]

Windows have the option of including a text log. This is enabled for the ‘Composite’ test display, but
may be enabled for other displays by passing the appropriate parameter in the code.

Line Plots
[1]

4.1.2

4.1.3

This category includes a large number of plots of one dimensional data, including:
•

Sound Speed Profiles

•

Correlation

•

Raw data time series plots

•

Plots of estimates of various values (such as the estimated AUV bearing or range)

Lofargrams
[1]

Lofargrams consist of two components: a greyscale gram plot with time and frequency axes, and a
linear A Scan plot with amplitude and frequency axes.

[2]

When moving the mouse over the gram plot, the line of data at the mouse position is shown in the A
Scan plot.

[3]

Either the gram plot or the A Scan plot may be zoomed, and the frequency axes should stay
synchronized.

Tactical
[1]

This plot shows a graphical representation of a lat/lon bounded region.

[2]

The most recent position for the CDHA and the first AUV position estimate are displayed. A track of
the historical position estimates is also plotted. These tracks may be shown with time markers at user
selectable intervals.

[3]

Readouts are provided for the lat/lon of the mouse position, and range/bearing from the CDHA to the
mouse position.

[4]

The displayed lat/lon region may include a pole (for example, by using longitude -180 to +180 and
latitude +80 to +90).
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4.2

4.2.1

4.2.2

4.2.3

Configuration
[1]

Dialog boxes are provided for editing various system configuration settings, as described in the
sections that follow.

[2]

Configuration settings may be saved or restored using the ‘Save Configuration’ and ‘Load
Configuration’ options in the File menu of any display. An XDR file format (IDL’s proprietary
format for save files) is used. The files consist of a nested hash containing key, value pairs with all of
the configuration settings.

[3]

The tim_test.pro procedure automatically loads configuration settings from a file named
‘ats_config.sav’ in the user’s home folder, if such a file exists. This is the default filename used when
saving configuration settings.

AUV Parameters
[1]

Currently, this just lets you choose the wav file to use as the replica when computing time delays (and
for generating test data).

[2]

If the wav file is not already at the sample rate defined in the System Parameters, it will be resampled
to that rate.

[3]

You can also bring up a time series or lofar plot of the selected file as a quick sanity check.

CDHA Parameters
[1]

Here you have the option to perform roll/pitch/yaw corrections on the bearing/elevation angles
produced by the phase gradient algorithm. This should normally be done.

[2]

An option exists to bind the CDHA position to the ship position. When bound, any lat/lon position
updates for the ship will automatically update the CDHA position. These automatic CDHA position
updates will use the depth specified and apply the specified offset from the ship heading to determine
the yaw of the CDHA.

[3]

The channel number to use as the ‘Omni’ channel of the CDHA can be selected. This channel will be
used for time delay calculations and be displayed in lofargram and time series plots.

Environmental Parameters
[1]

This lets you edit a sound speed profile and enter a bottom depth.

[2]

You can modify a depth or speed by clicking on that cell in the table.

[3]

Rows can be inserted or deleted by right clicking in the table. Inserted rows are given default values
interpolated from the surrounding rows.

[4]

If you edit the depth of a row, the rows are re-sorted by depth.

[5]

The profile can be plotted and this plot should be kept in sync with changes made to the table.

[6]

Profiles may be imported or exported as CSV (comma separated value) files.
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4.2.4

4.2.5

LOFAR Parameters
[1]

Fast Fourier Transform (FFT) size, overlap, and window are selectable. The windows supported
include rectangular, Hann and Hamming.

[2]

Normalization method and parameters are also selectable. By default, the normalizer is currently off
(it is a little slow right now). Two Pass Split Windows and Two Pass Mean normalizers are also
supported.

[3]

Separate configurations are saved for use on raw and preprocessed data.

Phase Gradient Parameters
[1]

4.2.6

4.2.7

4.2.8

The frequency range to operate on, and whether to use a cut from the raw or preprocessed data are
selectable. Normally, raw data and not preprocessed data would be used for the phase gradient
algorithm.

Preprocessing Parameters
[1]

This is for an initial preprocessing step on the data prior to computing time delays. We move the
frequency range of interest down to baseband to let us drop the sample rate. This is important for the
efficiency of the time delay estimation.

[2]

This dialog lets us choose a bandwidth (decimation factor), the center of the frequency band of
interest and the filter length to use in the decimation. preprocess.pro does the actual work.

[3]

Note that there are raw and preprocessed lofargram options in the Displays tab of the
ATSDebugDialog, showing the data before and after preprocessing.

[4]

If you select a bandwidth of 15,000 Hz (assuming the system sample rate is set to 30,000 Hz), this
preprocessing step is effectively disabled.

System Parameters
[1]

Here you can select the sample rate for the raw data, which defaults to 30000 Hz.

[2]

The number of remote nodes (though this is currently capped at 0).

[3]

The serial port for the GPS to be used for ship position updates may also be selected.

Tactical Parameters
[1]

You can select the world model (sphere or WGS 84 ellipsoid), projection (currently just two, but it is
easy to add others) and associated reference point.

[2]

A lat/lon grid can be configured.

[3]

Options to interpolate track positions and to label tracks at regular time intervals are provided.
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4.3

[4]

The display of high or low resolution continents and shoreline can be enabled (these are data sets that
come with IDL). By default, we use the low resolution one – it is faster and there are display artifacts
in some parts of the globe with the high resolution data sets.

[5]

A georeferenced TIFF file may also be displayed.
We use the NOAA 1-minute
bathymetry/topography data (see the installation instructions above for a URL) to give a little more
context to the tactical.

Test Data Generator
[1]

The ATSDebugDialog provides options for generating synthetic test data.

[2]

On the AUV tab, the user may select a lat/lon and depth for the true AUV position.

[3]

On the Ship tab, the lat/lon and heading of the own ship may be defined. Three buttons are provided:

[4]

•

Set Ship Position applies the latitude, longitude and heading values to the own ship track. If the
CDHA is bound to the own ship position, this will cause a CDHA position update as well.

•

Set Ship Lat/Lon Only will only update the latitude and longitude of the own ship, leaving the
heading unchanged. This is intended to simulate the arrival of a GPS position for the own ship.

•

Set Ship Heading Only will only update the heading of the own ship, leaving the latitude and
longitude unchanged. This allows the heading to be updated without affecting a position which
may already be coming from a GPS.

The CDHA tab provides a number of controls and readouts for synthetic data generation:
•

The depth of the CDHA is indicated. This may be adjusted using the CDHA parameter dialog
box.

•

The range/bearing from the CDHA to the AUV is indicated. This is updated when the lat/lon of
the ship or the AUV are modified (assuming the CDHA is bound to the own ship). Note that the
range is in the horizontal plane.

•

Pitch and roll angles for the CDHA may be entered.

•

The yaw angle for the CDHA is reported. This is updated automatically as the ship heading (in
the Ship tab) or the offset from the ship heading (in the CDHA parameter dialog) is updated.

•

The sound speed for the CDHA depth is reported. This is updated if the CDHA depth or the
sound speed profile is modified. This sound speed is used to calculate the time delay used for
synthetic raw data generation.

•

An elevation angle may be defined. This is the vertical arrival angle (relative to the horizontal
plane, not the CDHA) of any synthetic raw data generated.

•

The horizontal and vertical arrival angles relative to the CDHA are reported (as Theta and Phi).
These are updated as the bearing to AUV or elevation angle are changed, or as the orientation of
the CDHA (as defined by the pitch, roll and yaw angles) are updated.

•

A signal to noise ratio synthetic raw data may be defined.

•

The length of synthetic raw data to generate may be defined.
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[5]

•

The time delay of the received pulse is reported. This is calculated from the horizontal range to
the AUV and the sound speed at the CDHA depth. In order to ensure that the pulse is received by
the CDHA, check that the data length being generated is at least as large as the time delay plus
the duration of the pulse.

•

Buttons are provided for setting the CDHA orientation (consisting of roll and pitch – yaw is set
implicitly via the CDHA heading offset and the ship heading), generating a set of acoustic data,
and for importing/exporting the acoustic data as a wav file.

On the Environmental tab, white or red background noise may be selected. Red noise is formed by
integrating white noise and the spectral density is inversely proportional to the square of the
frequency. Red noise was added as a simple method of testing the normalization in the lofargrams.
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5

5.1

APPLICATION PROGRAMMING INTERFACE
[1]

The GUI code has been implemented using an object-oriented design.

[2]

Object oriented designs have the advantage that code can easily be reused, and adding new features
similar to existing ones requires little effort once one is familiar with the API.

[3]

Object oriented designs also have the disadvantage that the code implementing a specific feature is
often split across many procedures, each implementing a small part of the functionality. It can be
difficult to know how the code works until the operation of a number of objects is understood.

[4]

This section attempts to describe the overall design of the code

ATSObject
[1]

The vast majority of the objects in the system inherit from (i.e., reuse the functionality of) ATSObject.
The only exceptions are objects that are involved in the implementation of the ATSObject class itself.

[2]

The primary reason for the existence of ATSObject is to provide one interface for text information to
be shown to the user or logged in a log file.

[3]

Every ATSObject supports the following parameters:

[4]

5.2

•

NAME: a string used to identify the object in log messages

•

DEBUG: a flag to turn on debugging output for that object

•

LOG: a history buffer for log messages, shared across all objects in the system

ATSObject also provides a number of methods, including:
•

Debug: print a message useful for debugging the system (if the DEBUG keyword was set when
constructing the object)

•

Info: print an informational message

•

Warning: print a warning message

•

Error: print an error message

ATSData
[1]

One of the goals when designing the system was to have a GUI that updates automatically whenever
data arrives from the CDHA or is modified by the user. In order to achieve this, the various
components of the GUI need to be created and hooked together even before the first set of acoustic
data arrives from the CDHA.

[2]

The ATSData object provides a wrapper around a particular set of data (such as the raw acoustic data
from the CDHA or the bearing estimate from the CDHA to the AUV). This ATSData wrapper is
created immediately on startup, one for each particular set of data in the system, and provides a
centralized location for displays and algorithms to:
•

Determine the time the data was recorded
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5.3

Find information about the axes of the data (frequency ranges, etc)

•

Get notified when the data changes (the lofargram plot, for example, uses this to refresh the
display with a new image when the data has changed)

[3]

Objects can get notification of changes by adding a callback to the data object. A callback is simply a
procedure to call whenever the data object is updated. For example, the ATSTacticalPlot adds a
callback to the ATSTacticalParms. Whenever the user modifies a parameter to the tactical (such as
changing the spacing of lat/lon grid lines), the on_parms_change method of ATSTacticalPlot is called,
triggering a refresh of the tactical plot.

[4]

There are a few specialized types of ATSData, including:
•

ATS1DData: one dimensional (i.e., vector) data, such as a sound speed profile. Commonly used
by line plots.

•

ATSTimeHistory: a special case of ATS1DData for values that vary over time.

•

ATS2DData: two dimensional (i.e., matrix) data, such as lofargram data. Currently only used by
the gram plot.

•

ATS1DSlice: a row of an ATS2DData that behaves like an ATS1DData. This is used for the line
of lofargram data plotted in the A Scan. The row to be plotted can be changed.

ATSParms and ATSParmsDialog
[1]

[2]

5.4

•

The configuration dialogs described in Section 4.2 are implemented in two pieces:
•

An ATSParms object, containing the values of each configuration setting. There is one
ATSParms object for each configuration dialog (for example, the ATSAUVParms object stores
settings for the AUV dialog). These objects contain the values to be used throughout the system
and are only updated when OK or Apply is pressed in a configuration dialog.

•

An ATSParmsDialog object, containing all of the code to handle the dialog box used to modify
the configuration settings.

ATSParms provides callbacks whenever parameters change (so that displays may be refreshed when
parameters change or configuration settings are loaded from a file).

ATSDisplay and ATSPlot
[1]

All of the graphical plots can be combined together as subplots of an overall window. The
‘Composite’ test display of the ATSDebugDialog demonstrates this feature. This is implemented
using two key classes: ATSDisplay and ATSPlot.

[2]

ATSDisplay represents an arbitrary rectangular region of the overall window. Its position is specified
as fractional coordinates within the parent window (for example, the left half of the window would be
used by an ATSDisplay with x coordinates from 0 to 50% and y coordinates from 0 to 100%). In fact,
there are two positions associated with each ATSDisplay: the ‘position’ corresponding to the limits of
the box containing any plot of actual data, and the larger ‘clip’ region which includes the screen
region occupied by axis labels. When adding a display to a window, it is important to specify both the
‘position’ and the ‘clip’ region.
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[3]

The ATSDisplay objects are organized into a tree structure. For example, the ‘Composite’ test display
consists of four graphical plots, each with its own ATSDisplay (the time series in the top left,
lofargram in the top right, tactical in the bottom left and correlogram in the bottom right). The
lofargram in the top right, however, is itself comprised of a gram plot and an A scan plot.

[4]

The ATSDisplay class handles all of the logic necessary for handling these rectangular regions. This
includes assigning actual pixel dimensions and positions to these regions (based on the overall size of
the window and the fractional positions of the regions) and updating these when the window is
resized.

[5]

The ATSPlot is a special case of ATSDisplay that corresponds to an actual graphical plot of some set
of data. Every ATSPlot has a corresponding ATSData object (containing the data to be plotted) and
an ATSParms object (containing parameters affecting how the data is to be presented). The ATSPlot
automatically creates the necessary callbacks to refresh the display whenever the data or parameters
change.

[6]

In order to reduce screen flicker and support quick highlighting of selected regions and cursor
positions, three separate but identically sized draw widgets are used for each graphical window:

[7]

[8]

•

The ‘onscreen’ widget, which is the one actually visible in the window

•

The ‘offscreen’ widget, used to assemble the plot image before it is actually presented on screen

•

The ‘spare’ widget, containing a copy of the plot without any highlights of a selected region or
lines for the cursor position

When data is updated or the window is resized, the entire contents of the window must be
recalculated, and the following steps are performed:
•

Fill the clip region of the ‘offscreen’ widget with the background colour.

•

Plot the data into the ‘offscreen’ widget at the plot position (this may require multiple passes to
include such things as grid lines and may be relatively time consuming).

•

Plot the axes at the plot position.

•

Copy the clip region of the ‘offscreen’ widget to the ‘spare’ widget.

•

Add cursors and selection region highlights to the ‘offscreen’ widget as necessary.

•

Copy the clip region of the ‘offscreen’ widget to the ‘onscreen’ widget, causing the final
complete image to appear in the window.

When the mouse is moved or the selection region changes, the display can be updated with the
following much quicker steps:
•

Copy the clip region from the ‘spare’ widget to the ‘offscreen’ widget.

•

Add cursors and selection region highlights to the ‘offscreen’ widget as necessary.

•

Copy the clip region of the ‘offscreen’ widget to the ‘onscreen’ widget, causing the final
complete image to appear in the window.
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